
Troubleshooting & Tips in Collecting Images
Experience is your best teacher for collecting the best images for your computer. 
By experimenting with various scanner and camera settings and techniques you 
will learn how to produce excellent quality images with greater efficiency and 
ease.

    Tips for scanning
    Tips for using a digital camera
    After I have my image, I want to...
    Scanner troubleshooting guide
    Digital camera troubleshooting guide

Limit the image size when possible
Small images require much less hard disk space and processing time than a large ones. Be aware of how much disk 
space you have on your system when you take your pictures. If your available disk space is limited, you may only be 
able to copy a few photographs from your camera to the computer. Some cameras allow you to adjust the photo 
compression before you take the pictures. 
By increasing the compression, you will get smaller file sizes. This allows you to collect more images in your camera, 
(like getting a longer roll of film) and copy more to your computer. However, your images may not be as sharp or 
accurate than images with lower compression.
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Limit the image size when possible
Small images require much less hard disk space and processing time than a large ones. Before you start scanning, 
note the predicted file size in KB (kilobytes) and compare it to your available hard disk space. If the expected file size 
for the scanned image will be greater than the available disk space, your scan will be faulty. To control file size, make 
sure to select only the area you want to keep before you start scanning. Here are some other things you might try to 
limit the file size:
1. If your scanner supports sharpening, try scanning at a lower resolution with sharpening.
2. Save True Color or Grayscale images as JPEG (*.JPG) files.
Note: Although iPhoto Express reads bitmap and vector files, you can only save files in a bitmap format.
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Scan in the same color mode as the output device
For most accurate reproduction, scan your images using the same data type as that of the final intended output 
device. This may also help you control file size. Here are some examples:
    OCR Text Black and white.
    Line art Black and white.
    Laser printer Grayscale.
    Monitor 256/True color (depending on the video driver).
    Post production True color (CMYK).
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Scan good quality images and text
You always lose some information when you scan. But by carefully choosing your images and settings, you can 
minimize problems. For example, don't try to scan extremely light or dark images or those with very low contrast.
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Avoid photographing documents or large blocks of text
If you wish to copy a printed document or page from a book or magazine into your computer, use a scanner instead 
of a camera. Digital cameras, as a rule, cannot adequately record the image with sufficient data to make the resulting 
image readable because:
    The resolution is probably too low.
    The lens is too small.
    Most digital cameras save their photos using a lossy compression method.
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Scan photographs instead of printed pictures
Images from magazines or books are composed of tiny dots. The typical resolution for color typesetting is 180 or 300 
dpi, so scanning at higher resolutions produces no better results. As a matter of fact, they may even be worse. The 
scanner often sees white dots in between the printed color dots. To preserve accurate toning details, scan 
photographs instead of printed materials.
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Highest resolution is not always the best selection
High resolution images take enormous amounts of disk space. If the image is scanned at higher resolution than what 
it is displayed at, that does not mean the result is going to be better. The standard color typesetting resolution is 180 
dpi and a standard photograph ranges from 400 to 600 dpi. Similarly, exceeding the resolution capabilities of your 
output device or monitor will result to a no gain image quality. A standard VGA monitor display resolution in Windows 
is 72 dpi (Windows large fonts) or 96 dpi (Windows small fonts).
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Experiment with different settings
Scan images using different settings. Compare the results on your screen to select the one that suits your needs. 
iPhoto Express has many functions to help you enhance your scanned images until you are satisfied with the results.
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If you have trouble in getting your scanner to work in iPhoto Express...
When using iPhoto Express to acquire an image, make sure that your TWAIN driver, (provided by the scanner 
vendor), is correctly installed. This TWAIN driver sends the acquire command from the application to the scanner and
processes scan data from the scanner to be given to the application.    Also, you need to select the data source first 
before starting the scanning process. There may be more than one device attached to your computer and you need 
to specify which one to use. These steps will help you get started.
1. Check if the scanner power switch is on.
2. Check if there are any loose connections between your computer and the scanner. Try scanning again.
3. If it still doesn't work, choose "Acquire: Select Source" from iPhoto Express's File menu.
4. Check if your scanner's model name is on the data source list. If not, install the TWAIN driver to Windows 95 and 

then repeat step 3 to check if it was installed correctly. (If you still can't find your scanner's model name, please 
contact your scanner vendor for more information on how to correctly install the TWAIN driver in Windows 95.)

5. From the File menu, choose "Acquire: Image." 
6. Specify the destination for the acquired image, calibration scheme to apply, and select the post processing options

to apply in acquiring.
7. Click Acquire to start scanning.
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If you're getting a "TWAIN error" message...
There are three systems that interact with each other when you capture an image: the TWAIN-compatible input 
device, the TWAIN driver, and the TWAIN-compatible application. Each has its own set of conditions that must be met
before you can successfully scan an image. Most of the time the TWAIN-driver is not properly installed and this is 
what's causing the problem. Try the following before contacting your vendor about a problem.
1. make sure power for your camera or scanner is available.
2. Check the connection between your computer and the camera or scanner and then try again.
3. From the File menu, choose "Acquire: Select Source" to see if your data source name is listed. If yes, select it. 

Otherwise, install your TWAIN driver and try again. 
4. If it still doesn't work, please contact your vendor for information on how to install the TWAIN driver in Windows 95 

or an update and how to avoid hardware conflict with the interface adapter. 
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If your scanned image quality is poor and filled with horizontal lines...
Chances are your scanner is not calibrated. Calibration is the process of correcting the scanner to account for 
differences between the monitor, scanner, and the printer. Try the following:
    Check your scanner calibration test image and software routines that are provided by most scanner vendors. 

Make sure that this is correctly set.
    For hand-held scanners, try scanning slower and steadier. Make sure that the image to scan is placed on a 
flat surface.
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If your scanned image has a lot of spots...

        

Images that require a lot of colors need to be scanned at a higher resolution to blend colors more smoothly.
1. Check your scanner resolution. Your settings may be low for your output device.
2. Check your monitor display settings. If you are at 256-Color mode settings, change it to HiColor mode(16-bit) or 

True Color mode (24-bit) for 16.7 million colors.
    How to calculate resolution for output devices
    How much resolution is enough
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If your scanned image's colors are incorrect...

          

Most desktop color scanners scan images by using red, green, and blue light sources, but most color printers 
generate images by using cyan, yellow, magenta, and black inks. As the image data is translated from one device to 
another, the resulting colors may shift and become unacceptable. Even when working with monochrome images, 
details visible in the shadows and highlights may be lost when printed out. Check your scanner calibration test image 
and software routines that are provided by most scanner vendors. Make sure that you have the correct settings.
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If your scanned image has jagged edges and lacks details...
Scanning at too low resolutions commonly cause this problem. Since scanning loses information during the process, 
lower resolution settings will detect even less image data. Check the resolution settings, they may need to be set 
higher.

    How to calculate resolution for output devices
    How much resolution is enough
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If your scanned image display is too large or too small on the screen...
Images displayed on the screen are related to the monitor's resolution settings. To change your display resolution:
1. Right click on an empty space on your desktop.
2. From the Windows Display Properties dialog box, select the Settings tab.
3. From the Desktop area, drag the slider to higher resolution for small sized images or lower resolution for larger 

ones.
    How to calculate resolution for output devices
    How much resolution is enough
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If your scanned image has patterns...

          

They are caused by scanning a previously halftoned image or changing the size of a scanned image in an 
application. Try the following suggestions:
    Avoid sharpening when halftoning.
    Scan halftone images in the right direction to avoid rotating after scanning.
    Select halftone diffusion to scan previously halftoned images when using a desktop printer as an output 
device.
    Lower the resolution by a small amount when scanning grayscale or color images.
    Place one or more sheet protectors on the scanner glass when scanning original artwork. Put the image to 
scan face down on top of the sheet protectors.
    Try using scaling in your scanner to change the image size before bringing it into an application.
{button ,AL(`Reference1',0,"",`troub')}      Other common scanning problems



If you're scanning an image that's taking too long...
The scanning process time depends on the produced file size of the image being scanned, scanner settings, and 
your computer configuration such as the RAM, CPU, hard drive, and bus speed. Try the following steps to control the 
speed without changing your computer configuration: 
1. Check the file size of the pre-scanned image. Larger files take longer processing time.
2. Select only the portion needed. 
3. Choose the best resolution settings.
    Limit the image size when possible
    How to calculate resolution for output devices
    How much resolution is enough
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How much resolution is enough
When scanning, the relationship between your scanner and the output device to use is important in determining the 
resolution. The following suggestions may be helpful in deciding:
    Scan for the intended output device. For monitors, use 72 dpi (Windows large fonts)-96 dpi (Windows small 

fonts), laser printers 300-600 dpi, and photo-quality 1200-2400 dpi.
    Scan at higher resolution (2x the original) when doing extensive image processing to work with as much 
information as possible.
    Scan at higher resolution when enlarging the image to scan.
    Scan at 1.5 to 2x the intended halftone screen's lines per inch when sending the file to a post production 
house to create halftones.
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If your scanned image is too light or too dark...

      

      

1. Check if your scanner have a brightness control feature. If yes, use it to adjust the brightness. If none or if after 
adjusting you're still not satisfied with the result, continue with the next step.

2. Check your scanner calibration to adjust the color differences between your scanner and the output devices.
3. Use the scanner calibration test image and software routines that are provided by most scanner vendors.
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How to calculate the resolution for output devices
The relationship between your scanner and output device is important in choosing the right resolution. Scanners 
reproduce grayscale and color variations by increasing the amount of data for each pixel (or dot) in a picture. Printers 
however, simulate grayscale and color variations by arranging dots into larger ones called halftone cells. Desktop 
laser printers generate 53 halftone cells per inch, whereas high-resolution image setters print up to 133 halftone cells 
per inch. While printer dots are typically measured in dots per inch (dpi), halftone cells are measured in lines per inch 
(lpi). Use this formula in calculating the resolution to use in scanning grayscale and color images for your output 
device.
1. Multiply the lpi (lines per inch) setting of your output device by one and a half. 
2. Set the result to be the dpi setting for the scanner. For example, if your final output device is a desktop laser 

printer, that will be 53 x 1.5 to get the dpi setting for the scanner. In this example, the appropriate dpi is 80. (Round
off decimals.)
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Benefits of a 30-bit internal scanner (vs. 24-bit)
Some scanners provide a 30-bit scanning capability for color images, and 10-bit scanning capability for grayscale 
images. This feature allows you to capture additional data of the image to scan.
    The additional data captured results in better image quality. However, most software applications, including 

iPhoto Express, support only 24-bit files.
    Shadow detail is captured better. This is useful when scanning darker images. It also improves the results 
when the original image is poorly exposed.

Gaps resulting from the tone mapping process are minimized.
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In scanning, the tones of the original image are mapped to the modified tones in the scanned image. When the range 
of input tones is smaller than the output tones, this results in gaps in mapping of the scanned image. Gaps cause 
color problems in the scanned image and are most apparent in grayscale images. A 30-bit internal scanner's range of
input tones exceeds the range of output tones, thus eliminating gaps in the mapping process, resulting in more 
continuous and high-resolution tones in the scanned image.



Create an additional area around the scanned image
After capturing your image, you may want to create additional spaces for frames, shadows, or other information. 
Here's how:
1. Capture your image using the Scan or Import task in the    Start section of iPhoto Express.
2. As soon as iPhoto Express finishes capturing, it shifts to the Adjust section. Click "Frame & Shadow." 
2. Choose a color or texture for the frame and set its width.
3. Choose a color and direction for the shadow.
4. Increase the x offset to make the shadow larger horizontally; reduce to make the shadow smaller.
5. Increase the y offset to make the shadow larger vertically; reduce to make the shadow smaller.
7. Click OK.
iPhoto Express resizes the image to include the added items.
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Change the background/foreground color of my image
Sometimes you may want part of the photo or scan to appear against a different backdrop or setting. Here is one way
to change the background or foreground colors.
1. Capture your image using the Scan or Import task in the    Start section of iPhoto Express.
2. As soon as iPhoto Express finishes capturing, it shifts to the Adjust section. Click "Enhance" to switch to the 

Enhance section. 
3. Click "Select" to choose a selection tool and select the area you want for the background. (If it is too difficult to 

select the background, try selecting everything else. Then right click on the image and choose "Invert" to change 
the selection.)

3. Press Ctrl+F to open the fill dialog box and select a color or pattern for the background.
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Add some color to my Black & White /    Grayscale images
Sometimes, adding just a hint of color to a black and white or grayscale image does wonders for emphasizing a 
subtle detail. Here's how to do it:
1. Open the image in the iPhoto Express workspace.
2. From the Photo Menu, choose "Data Type"; from the submenu, choose "True Color". This converts your image to a

full color format.
3. Click "Enhance" to switch to the Enhance section and use the painting tools to colorize your image.
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Join two images
When you can't fit your entire image in one frame, consider splitting it with overlapping portions and then joining the 
pieces by following these steps:
1. Make sure both images you want to join are grayscale or RGB true color images and open in the iPhoto Express 

workspace.
2. Select one of the images to join. (It doesn't matter which.)
3. From the Edit menu, choose "Stitch."
4. Select the other image for stitching.
5. Drag the images so that they are in the right order.
6. Select the Manually option and check "Auto fine tune."
7. Press the Shift key and click on a reference point in the original image.
8. Press the Shift key and click on a point in the other image that should be close to the point you clicked on in step 

7.
9. Click OK.
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If your image to scan is too big for your scanner
When scanning an image that doesn't fit in your scanner, try splitting it into portions and then use iPhoto Express to 
join them together.
    Join two images
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    If you have trouble in getting your scanner to work in iPhoto Express... 
    If you're getting a "TWAIN error" message... 
    If your image to scan is too big for your scanner...

    If your scanned image display is too large or too small on the screen... 
    If your scanned image is too light or too dark... 
    If your scanned image's colors are incorrect... 
    If your scanned image has a lot of spots...
    If your scanned image is poor and filled with horizontal lines... 
    If your scanned image has jagged edges and lacks details... 
    If your scanned image has patterns... 
    If you're scanning an image that's taking too long... 



    Scan in the same color mode as the output device 
    Scan good quality images and text
    Scan photographs instead of printed pictures 
    Limit the image size when possible 
    Highest resolution is not always the best selection 
    How much resolution is enough 
    How to calculate resolution for output devices 
    Experiment with different settings 
    Benefits of a 30-bit internal scanner (vs. 24-bit) 



    Create an additional area around the scanned image
    Change the background/foreground color
    Paint some colors on my Black & White/Grayscale scanned image
    Join two images



Take pictures of nearby subjects
Make sure the subject of your photograph is not too far away. Unlike regular cameras, digital cameras have a fixed 
resolution for the photographs they take. If your subject is more than 30 feet away, it probably will not be clear in your 
photograph. As a rule, distances between 5 and 15 feet are best for digital photographs.
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    Make sure you have adequate lighting 
    Take pictures of nearby subjects 
    Avoid photographing documents or large blocks of text 
    Limit the image size when possible 
    Focusing your camera 



    If your camera doesn't work... 
    The batteries are OK, but the camera still won't shoot... 
    The batteries seem to run out too quickly... 
    If you're getting a "TWAIN error" message... 



Make sure you have adequate lighting
Just like with normal photography, lighting plays an important role in digital photography also. If your subject is too 
dark for your regular camera, it is probably too dark for the digital one also. And unlike regular cameras, most digital 
cameras do not allow you to change shutter speeds, so the option of exposing an image longer in dark environments 
is not available. Check your camera's operator's guide for details on the optimal lighting requirements for your 
camera.
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Focusing your camera
Many digital cameras have advanced auto-focus features to help you capture the best possible photo with the least 
difficulty. But sometimes the lighting or other conditions make it difficult for your camera to focus effectively. Here are 
some ways to make sure the subjects of your pictures are as clear as possible:
    Low contrast, Strong backlight, or Bright reflections If any of these conditions exist, focus on another subject

that is about the same distance from you and lock the focus on that subject. Then return to your subject to take 
the picture. (See your camera's user manual for how to lock the focus.)

    Parallel lines If your subject consist of many horizontal lines, (for example steps or a ladder), rotate the 
camera 90-degrees to focus. Then return the camera to the correct angle and take the picture.
    Multiple distances If the subjects of your photo are at different distances from you, focus on the one that is most

important to take the picture. (If you focus on a subject in between your primary subjects, chances are both 
subjects will be out of focus.
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If your camera doesn't work...
Chances are , it is just a small oversight that is preventing you from using your camera. Check the following to make 
sure everything is OK:
1. Are your batteries installed properly and charged? Check and replace them if necessary. It is always a good idea to
have a spare set of fully charged batteries handy when you use your camera. (Note: Always replace all the batteries 
with a fully charged set. Doing partial replacements with batteries holding different level of charge can lead to 
unstable camera operation and shorten the lives of all your batteries.)
2. Are you using the correct kinds of batteries? Check your camera's user manual to make sure the batteries in your 
camera are the right type.
3. The contacts between the batteries and the camera are dirty. Remove the batteries and, using a clean, dry cloth, 
carefully wipe the batteries and the camera contacts to remove dirt and other foreign particles. Then replace the 
batteries in the compartment.
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The batteries are OK, but the camera still won't shoot...
Take a moment or two to make sure your camera is set properly to take pictures:
1. Make sure your lens cover is open
2: Check to see if your storage device is properly inserted into the camera.
3. Make sure you have enough space available in the storage device for another picture. (It is always a good idea to 
keep at-least one extra storage device with you at all times.)
4. If you are taking indoor flash photographs, make sure the flash is fully charged. Most cameras have a flash 
indicator that tells when the flash is ready and when it is recharging.
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The batteries seem to run out too quickly...
The rate at which battery power gets used depends on several conditions. Here are some things to check and be 
aware of:
    Temperature Batteries get used up faster in extreme temperatures. If you plan to take pictures in sub-
freezing or extremely hot conditions, your battery life may be affected. Some cameras may accept specially designed 
batteries for these times. Check your camera's user guide for more.
    Poor charging practices Recharging partially used batteries often shortens the total length of a charge. 
Make sure you fully discharge your batteries before charging them again.
    Old batteries If you haven't used your batteries for a long time, they may be "stale" discharge and then 
charge them again to "freshen them up."
    Dead batteries If you have used these batteries many times, it is possible that they can no longer hold a 
charge. Buy a new set of rechargeable batteries.
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Taking pictures using the flash
Flash photography is pretty easy using today's modern cameras. Still there are a few tricks you can learn to enhance 
your ability to take the best possible photographs.
    Avoiding "Red Eye" "Red Eye" occurs when your subject's eyes have trouble adjusting to the change in lighting

due to the camera's flash. There are a couple ways to correct this. First, if your camera has a "no redeye" flash 
setting, use it when you take flash photographs. This causes the flash to blink rapidly before the camera takes 
the picture, thus enabling your subject's eyes to adjust to the light. If your camera does not have this feature, use
the "Red Eye" task in the iPhoto Express Adjust group to fix the problem after you take the picture.

    Washed out pictures Most professional photographers try to avoid shooting any kind of flash photography 
straight on. This is because the flash often creates unwanted shadows and washes out other important parts of 
the photograph. By supplementing the light with outside sources, and by diffusing the light through large screens,
you can prevent this problem from occurring. But for most of us, this is an expensive and complicated procedure.
Fortunately, iPhoto Express offers an alternative: Use the Color Balance and Hue and Saturation commands in 
the Color Task of the Adjust group to fix up your photo after you take it.

    Shooting through glass Try not to take flash pictures of subject behind glass or other reflective surfaces head 
on. The light from your flash will most likely make your subject appear unclear, and will certainly fill your picture 
with an unwanted bright spot. You can avoid this by shooting these types of pictures at an angle. For best 
results, try shooting at greater than 60-degrees.
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